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NOTE TO MANUAL USERS
This Manual is a two-part package of materials for guiding and training on ICTs
(Information and Communication Technologies) and Sexuality Education for
Adolescent Girls. The two components of the package are designed to complement
each other and provide the basis for knowledge and practice.
Part one of this Manual provides handy information on Computer Basic Skill for
learning and acquisition. Part two provides elements of awareness raising,
instructions and tips on Sexuality Education for adolescents, especially girls.
Manual users interested in obtaining copies of the Manual should contact CI Office in
The Gambia.
Conscience International (CI)
Secretariat
16th Street Fajara
P. O. Box 4216 Bakau
The Gambia
Tel: +220 4498068 / 9982467
Fax: +220 4498068 / 4397995
Email: ci.gambia@gmail.com
info@conscience-international.net
Website: www.conscience-international.net
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Part One
Computer Basic Skill
Beginners level volume 1
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INTRODUCTION
Computer as a data processing device and is one of the means of communication in
the world today. Computer is an electronics device that can receive, process and store
information (data) in an automatic form. It is made up of hardware and software.
The hardware is parts of the computer we can see and touch, they formed the
mechanical, electrical and electronics parts of the computer system. The software of
computer is programs designed to enable computer system to function. These
programs are Disk Operating System DOS, Microsoft Windows and Linux operating
system.
Other program are called program of exploitation and program of application (ms
office) designed by Bill gate.
The basic fundamental principles of graphic design initiated by Microsoft Office which
comprises of MS– Word, MS– Excel, MS– Outlook, MS– Power point, MS– Access,
MS– Publisher and others. This basic application program helps us to develop skills of
creativities, design, reports and data base manipulations.
Examples of computer
Analog
Digital
High bride: The first computer (mainframe computer)
The personal computer (PC): This belong to mainframe computer system
Types of personal computers are desktop, mini-tower, full-tower and laptop or
palmtop
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COMPUTER SYSTEM

COMPUTER LAB PRECAUTIONS

 Ensure to cover the system after use.
 Do not drop heavy objects on the keyboards.
 Do not move any cable or materials at its place.
 Do not drink or eat when using the system.
 Always call the attention of the technical for error.
 Do not use or open the system without proper
 Understanding.
 Keep your desk clean after use.
 Do not drop used paper or any object in the lab
 Always switch off the systems after use.
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INTRODUCTION
TO
INFORMATION
COMMUNICATION TECHNOLOGY (ICT)

AND

Computer is one of the devices of communication widely used in the world today.
Computer works like human beings, but does not create things on its own unless human
instruction and ideas, it carries out different functions especially in areas of data
processing, communications and data management.
What is the definition of Information and Communication Technology (ICT)?
Information and communication Technology is a medium in which information can be
transfer from one area to another with the means of computer, fax, post, television,
telephone etc. See diagram below.

Diagram

What is Computer System?
Computer System is an electronic device that receives, process and stock information in
automatic form as data base or information. It made up of hardware and software. The
hardware is parts of computer we can see and touch. They consist of mechanical, electrical and
electronics parts of the computer system.
There are three type s of computer system and these are: 1. Analog 2. Digital 3. High bride i.e.
main frame computer.
The following are examples of computer system: - calculators, cellular phone, Digital Diary,
digital camera, personal computer (PC).
Types of personal computers are: desktop, mini-tower, full-tower and laptop or palmtop.
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COMPUTER INPUT AND OUTPUT DEVICES
Components of computer system and its functions:
Computer system functions in three major parts namely:
Input function with its devices;
The Central Processing functions with its devices; and
The Output functions with its devices.
The diagram below shows the typical function of computer system.
keyboard
mouse
microphone
disk
joy stick
flash drives
The CD
Scanner / cameras

Motherboard
Memory
Hard disk
Card of sound
Microprocessor
Reader of disk
Reader of CD
Power supply unit

Speakers
Screen
Printer
Camera

The Input unit is a medium in which instructions or command task are send to the central
processing unit. This unit consist of Keyboard, Mousse, Microphone, Compact disk drive
(CD), Flash drives, Readable card memories. Camera, scanner etc...
The Central Processing Unit (CPU) is where all the logic functions are being carried out.
This unit consist of Motherboard, Micro processor, Random access memory (RAM) - they are
quick and volatile, Hard disk drive and I/O Cards for Sound, graphic, network cards etc.
The Output Unit is the medium that gives out the final processed result from the CPU. These
devices are Monitor or Screen, Speakers and printer/ fax etc.

STUDY OF KEYBOARD OF COMPUTER
The keyboard is divided into three major parts namely:
1. Alphabet keys 2. Numeric keys 3. Function key i.e. f1 to f12
There are also Alphanumeric which consist of Alphabets and numbers
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There are two commonly used key boards namely; English and French Keyboards.
The French keyboard is characterise by AZERTY and English is characterise by QWERTY

In order to send information to the computer there are commands buttons use. The diagram below illustrates different command
used to send instructions to the CPU.
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Definition of keyboard commands
Keyboard is one of the input devices of computer system. It is a medium in which data can
be sent into the system with command instructions.
Escape
Permits to remove the foreign menus
Tabulation
Permits to write the paragraphs
Caps lock

Permit to activate capital letters
ALT Grd
Permit to activate arrobas
Back space or
Erase
Erase right verse to left
Delete
Erase left verse to right
Entrer
Permit to validate and go to new line
Direction touches

Permit to displace left and right or up and down
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STUDY OF MOUSE OF COMPUTER
Below are mouse of different control.
Laptop and desktop mouse.

The sign of the mouse is the cursor that appear on the screen while blinking
POINTER: it place the cursor (to carry on an element of the office)
CLICK: it push and lax the left button of the mouse
DOUBLE CLICK: it click quickly on two occasions on the left button of the mouse
TO MAKE SLIP: it point an object; to push the left button to maintain until
destination
Multi media system is a device of audio and video attach or integrated into computer
system. This device constitute speaker, woofer and microphone
Camera, Cellular and Scanner: These are input devices connected to the CPU. These
devices can be initiated into the computer with its disk of operating called (disk Driver)
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CD/DVD/Writer
The Compaq disk or Digital Versatile disk is one of the input device which read and
send command to the central processing unit its polyvalence nature make it capable of
reading CD ROM, CD audio, CD Video and also CD engraves writer CDR and CDRW;
Reads DVD and DVD Video and also DVD-ROMs.

It is possible to engrave or duplicate CD with minimum or maximum speed of the drive.
For example a CD of 8X has a maximum speed of 1200kb/s, 48X speed of 7200kb/s.
DVD of 8X of speed is the equivalent of CDrom drive of 24X.
Engraver of 24 x 10 X 32 is capable of engraving CDR of 12X one CDRW on 10X and
read CDROM 32X, replacement is possible between them.

CENTRAL
SYSTEM

PROCESSING

UNIT

OF

COMPUTER

Motherboard of computer
Mother board is one of the processing device units of computer system; it is where all the
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Hard Disk of Computer
The hard disk of computer can be represented by DD or HD. It is the main principal
storage unit of a computer. The system windows, data and programs are saved inside. The
capacity of hard disk is denoted in Giga bytes (GB).

OUT PUT DEVICE UNIT OF COMPUTER SYSTEM
Monitor or screen is one of the output devices of computer system. Signal, Data or
information are been display on it. Printer prints out the information
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STARTING MICROSOFT WINDOWS
Introduction
Before starting Microsoft windows program, ensure all the connection of the power and
other peripherals are properly connected. Switch on the monitor followed by the CPU. Wait
few period of time for initialisation of the peripherals and other parts of the computer to be
ready, this is called BOOTING.
PRESENTATION OF WINDOW
DIAGRAM

Booting will prompt to you to windows desktop which are the screen that is displayed after
the execution of exploitation of the computer starting. Icons: are images and symbols that
represent directories folders and files.
STARTING UP COMPUTER SYSTEM
Switch on the screen and then
Switch on the central processing unit
Wait for the initiation of the devices installed `booting` the action will prompt to you MS
Windows Desktop. The diagram above shows the windows desktop environment.
DESKTOP ICONS
DIAGRAM
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Windows start-up bar
Icons of different directories
The windows desktop consist of icons of different directories and start-up bar which
contain the start menu, time and date settings, minimized icon or directories.
THE ICONS OF THE DESKTOP:
MY COMPUTER is one of the icons on the desktop. It is made up of sub-directories like
local disk C: /, 31/2‘floppy drive A: /, Compact disk drive D:/ etc…………
In order to open my computer directories, double click on it.
You follow the same manner to open other sub-directories it contains.
A directories window consist of MINIMISE button to minimise the opened directories,

RESTORE DOWN/Maximise.
That is increasing and reducing the window

Then the close which is use for closing the opened window or directories

What are Directories:
Directories are made up of folders.
Examples are: 31/2 a: / (diskette)
C: / (Hard disk or local disk)
D: / (C.D)
E :/( flash drive or any storage disk)
Desktop is also directory
C.D compact disk, DVD Digital Versatile Disk.
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TECHNICAL DEFINITIONS OF THE FOLLOWING TERMS:
Folders: - folders are assembles of Sub-folders and files.
Files: - it consist of documents (data)
Documents: - documents consist of information or data. Data is the same as information.
In data or information management, directories could be replaced by departments, folders the branches and file individual documentation.

HOW TO CREATE FOLDERS
There are many ways one can create a folder, but will consider the method of creating
folder in the desktop.
DESKTOP METHOD
Right click on the mouse button in an empty space, menus appear in menu, go to new.
Menu appear, click on folder and write the name of the folder and press enter to validate
your folder’s name then click left of the mouse in empty space.
Diagram

The diskette 3/2 (A :)
NB: the procedure to create folder in the disk is similar for (the entire storage disk USB,
the CD, the local disk)
Double click on my computer icon to open (menu appears).
In menu, double click on the symbol of the disk that is 1, 2 any disk local open windows
will appear then click right button of the mouse in an empty space of the mouse (menu
appear).
In menu go to new (menu appears again) in menu click on folder (new file appears) write
the name of folder and press enter to validate your folder name then click left of the mouse
in empty space.
HOW TO RENAME, DELETE AND RESTORE FOLDER
How to rename an already created file: click right button of the mouse in an empty space of
the mouse (menu appears), in the menu click on rename and then write the name of the file
and then press enter.
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RETRIEVING DOCUMENT
In order to retrieve document in C: /, flash drive, compact disk ROM and memory card.
Step1
Double click on the directories specified.
Step2
Menu appears on the menu, click on the folder or sub-folder specified, search for your
document and double click on your document to open it.
HOW TO RENAME FOLDERS
With same procedure of delete one can rename as well.
Now position the mouse pointer on the file, folder and directory you want to rename then
right click the right button of the mouse in an empty space of the mouse (menu appears) on
the menu, click on rename, then write the new name of the folder, file or directories and
press enter.
HOW TO RESTORE A FILE (TO RECOVER A FILE)
First of all the restoration of the file in a recycle bin, this basket represent a trash basket for
the computer and this one receives all files that we deleted in the office. Double click on
the basket (menu appears) on the menu, to choose the file to restore and clicked on the
right of the mouse (menu appears) in the menu clicked on to restore and the computer
sends back this file in the office

INTERNET EXPLORER AND NETWORK
Internet explorer is internet browsing program used for searching information in internet
web site, it is commonly use for internet in place of other browsing software. Like Mozilla
Firefox, Google and Yahoo.
INTERNET EXPLORER
DEFINITION OF INTERNET EXPLORER
Internet explorer is a program which permits browsing or searching and share information
on the site web (server internet). It can also be called internet navigator.
LAN and WAN/ADSLWORLD.NET WORK
Local area network (LAN)/ wide area network (WAN) ADSL This is a wide area network
connection of internet service
HOW TO OPEN INTERNET EXPLORER
Double click on internet explorer icon on desktop and the content internet opens up then
type the address of your site in the dialog box address.
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HOW TO OPEN ELECTRONIC BOX
To open, double click on internet to explore in desktop and the content internet opens up.
Type the address following, http www.yhoo. com and press enter write and fill in the space
provided on the page and also fill the list of inscription that takes place before you, after
having finished to fill you will be ask for acceptance. Accept yourselves to create an
account on yahoo you will click (I accept and create my yahoo account in the menu that
appears, if you really have fill the list) yahoo will congratulate you to have succeeded
while giving you yahoo account.

UTILISATION OF MICROSOFT WORD

Microsoft word is a word processing software Application program used for typing
documents such as Letters, Memo. News letter, Journals, Article reports etc..
Method of opening MS Word
 Click on Start
 Go to Program
 Click on MS office
 Finally click on MS Word
Ms Word can also be open on the desktop if MS Word shot cut icons appears on the
desktop. In this case you will simply double click on it.
The action will open the active page of MS Word.
See the fig on below
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Active Microsoft Word Page DOC

Description of Word Tools bar

Active Word menu are:- Home, Insert, Page Layout, Reference Mailings, Review
and View

UTILIZATION OF THE HOME MENU
This menu represents the menu bar that consists of font face, font size, increase the font
size, decrease the font size, clear all the formatting from the selection, make the
selected text bold, Italicize the selected text, underline the selected text, draw line
through the selected text, create small letters below the text baseline, crease small
letters above the text line, make text look like it was highlighted with pen and change
the text color. See below figure.
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This menu consists of major command task such as CUT, COPY and PASTE.
The cut is used in cutting off the selected text or document to another place where
the cursor position appears.
The copy is the same as duplicate, it helps to copy the text selected to another place
where the cursor appear.
Paste is the command used to validate the cut or copy action.
The insert menu bar, this bar represents so many tools for word processing in MS-Word.
The contents o f the insert menu are as follow:- Cover Page: which helps you to insert a
fully formatted cover page

Blank Page this helps to insert blank page at the cursor position, Page Break that is to start
the next page at the current position

Page Break that is to start the next page at the current position
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TABLE
Table helps to insert or draw a table in to current document, Picture help to insert picture
from file, Clip Art helps to insert clip art into the document, including drawings, sounds,
movies or stock photography for concept illustrations. Shapes: this will help to insert
readymade shapes such as rectangle cycles, square, arrows, lines and symbols. See below
for more illustration

Smart Art Graphic this help for visually communication information. Chart, insert chart
to illustrate and compare data. Hyperlink help to create a link in the web site page a
picture e-mail address or a program, Bookmark, insert bookmark to assign a name to a
specific point in the document hence you can hyper link and jump directly to a
bookmark location.
Header is a title place at the head of the page. Footer is a write-up that appears bottom of
each printed page. Page number: insert page number help to insert number into the
document. Text box: helps to insert preformatted text box into the document. Quick part:
this helps us to insert reusable pieces of contents including fields and document properties.
See figure below

Word Art: this helps us to insert decorative text into our document. Drop Cap: this helps to
create a large capital letter at the beginning of a paragraph. Equation this helps to insert a
mathematical equation or help to build up your own equation. Symbol: helps to insert
symbols that are not in the keyboard.. See figure below.
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THE PAGE LAYOUT
The page layout is the same as page setup. It consist of page orientation, that is page
alignment and page position, Margins, page border, page color, page indents and page
spacing. Below shows all the contents
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What is a Spreadsheet?
A spreadsheet (called a workbook within Excel) is a powerful application which can be used
to store, manipulate, calculate and analyse data such as numbers, text and formulae. An
analogy can be drawn between a spreadsheet and an accountant’s ledger. A ledger is made up
of many pages, each page arranged into a series of rows and columns.
At its simplest level, a spreadsheet is used to enter numbers and perform simple calculations
but the capabilities of Excel extend far beyond this. Excel provides a number of features
including:
Functions for mathematical, financial and other calculations.
A selection of tools to facilitate “what if ” type analyses.
A Chart Wizard – to produce graphical representations of data held within workbooks.
Graphics to highlight information in worksheets and charts.
The Excel environment
To launch Excel, from the Start menu select Programs and choose Excel. Your screen should
Sizing
Help button
lookMenu
thebar
same as the one below.
Title bar
buttons
Standard
toolbar
Formatting
toolbar
Name box
(showing
active cell)

A1
Column
heading

Formula bar

Row
heading

Scroll bars

Status bar
Sheet tab

Task pane

Note the Formula bar, Status bar and the Scroll bars. Take a moment to locate these on
your screen.
It is possible to change the look of the default environment. A number of the view
options can be changed from the Tools menu, under Options and View.
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WORKBOOKS AND WORKSHEETS
On start up, Excel automatically loads a workbook, Book 1, as identified in the Title bar.
This workbook is a file in which you work and store your data. Each workbook can contain
a number of worksheets. The default workbook has three worksheets, each having a tab to
mark the sheet (Sheet1, Sheet2, and sheet3).
A worksheet is a grid-like area divided into columns and rows. Columns are labelled A, B,
C, etc., and rows numbered 1, 2, 3, etc. Each worksheet is made up of 256 columns and
65,536 rows.
The intersection of a column and a row is known as a Cell.
Each cell on a worksheet can be uniquely addressed by its column letter followed by its row
number (e.g. the first cell in the worksheet is A1).

A1

The active cell is now indicated by both the column and the row headings being
highlighted.
Entering data
Data are always entered in the selected cell. Position the pointer in the cell required before
entering data from the keyboard.
Types of data
There are three types of data or information that may be entered into a worksheet:
Labels (text)
Normally text used for headings or in lists.
Raw data which are used in calculations (i.e. numeric data only). These
Values
(numbers)
include dates.
Arithmetic or mathematical expressions.
Formulae

Values can be in many different formats and it is important for display and calculation
purposes that the correct format is used. Normally labels are left-aligned in cells, whilst
values (numbers) are right-aligned.

- 25
-

SAVE A WORKBOOK
From the File menu, select Save.
It is good practice to save your work at regular intervals. When saving a worksheet for the
first time the Save As dialog box appears. This box prompts you to give the worksheet a
filename and to select where the file is to be saved. The first time you use Save you should
check where the file is to be stored.

Select a drive
here.

Enter your
filename here.

Naming your file
In the File Name box type a suitable filename. You are advised to avoid spaces in your
filenames and to accept the default extension .xls. This is particularly important if you are
sharing files with other users. Try to use meaningful names, so files can be more readily
identified at a later date.
Saving
Once a file has been named you can use the Save command to update your file as you
work on it.
Save As
Use the Save As command when you wish not to overwrite an existing file, but to save
your work in a new file with a different name.

MODIFYING A WORKSHEET
Deleting rows and columns
Position the pointer in a cell in the required row or column.
From the Edit menu, choose Delete. The Delete dialog box appears.
Choose Entire row or Entire column as required.
Click OK
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Inserting rows and columns
Position pointer in a cell in the required row or column.
Click on the Insert menu and choose Rows or Columns.
Note: New rows are inserted above the pointer and new columns to the left of the pointer.
Undo and Redo
When you make a mistake or change your mind you can use the Undo command to reverse
your last commands or actions. Redo repeats your last command or action.
Undo
Click on the Edit menu and choose Undo or use Ctrl+Z. The Undo command changes to
show the most recent command or action. If the Undo command is unavailable the words
Can’t Undo appears greyed out in the menu.
To reverse more than one action at a time, click on the drop-down arrow beside the Undo
button, and then click the actions you want to undo.
Redo
From the Edit menu choose Redo.
If the Redo command is unavailable the words Can’t Repeat appears greyed out in the
menu.

PERFORMING CALCULATIONS
Calculating a Sum
You can use the AUTO SUM function to calculate the SUM of a series of numbers.
1. Type SUM. Press the right arrow key to move to cell E8.
2. Type =SUM (E3:E8).
3. Press Enter. The Sum of cells E3 to E8,
Type in the following spreadsheet, and format it to look like the sample below.
Instructions
Type in all text and numbers shown in the spreadsheet below.
Format all numbers as a currency.
Center the spreadsheet heading 'Sales for the Month' across the spreadsheet.
Format all text as displayed in the sample below.
Create formulas to display a total for each sales rep.
Create formulas to display a total for each product.
Create a formula to calculate the total sales for all sales rep's for the month.
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FORMATTING A WORKSHEET
All worksheets start with a number of predefined formats. As you work you may need to
change some of these formats to suit your own needs. In this section we will look at
some of the more common formatting options available.
Changing Font Size and Type
Excel has the same range of basic character formats as are available in the other Office
applications. Select the cells to be changed.
From the Format menu, choose Cells. The Format Cells dialog box appears as shown
opposite.
From the Font tab, select the required settings. The Font type, Style and Size as well as
Colour and other Effects can be selected, as shown on the right.
Select
the font
type here.

Font tab
selected.

Select the
font size

Select the font style
here.
Select Font style
here

Bord
er

Fill color
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Font color

Borders, patterns and colours
The appearance of the worksheet can be further enhanced with the use of borders and
colour.
From the Format menu, choose Cells and select the appropriate tab, either Border, Patterns
or Font
Change the Column Width and Row Height
Position the pointer in the column to be changed.
From the Format, menu point to Column and Width.
The Column Width dialog box appears displaying the default width.
Type the new width in the Column Width box.
Click OK.
Merge Cells
Select the cells that you wish to merge. Right-click and then select "Format Cells" from the
popup menu. When the Format Cells window appears, select the Alignment tab. check the
"Merge cells" checkbox.

Now when you return to the spreadsheet, you will find your selected cells
merged into a single cell.
Formatting a Worksheet

USING THE FIND AND REPLACE FEATURES
The Find and Replace features are time-saving techniques that allow you to rapidly change
the content of your worksheets.
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Finding Information
From the Edit menu, select Find… OR
Windows: Press [Ctrl] + [F]
 In the Find what text box, type the text or data to be found
 OPTIONAL: Adjust the searching options
 Click FIND NEXT The information is found and selected.
NOTES:
Clicking FIND NEXT again finds subsequent occurrences of the information in
the document.
If Excel cannot find the information you are looking for, a message to that effect
will be displayed.
 To close the dialog box, click CLOSE
Using the Replace Feature
The Replace feature is useful when you want to change the same piece of information
throughout your worksheet.
NOTES:
Use the Replace option to replace each occurrence of the information individually.
Clicking FIND NEXT will advance to and review subsequent occurrences.
Replacing Inf ormation
OPTIONAL: If you do not want to replace the information throughout the entire
document, select only those cells you want to change
Windows: To select non-contiguous cells, hold down [Ctrl] + click the desired
cell(s)
Macintosh: To select non-contiguous cells, hold down [command] + click the
desired cell(s)
From the Edit menu, select Replace...OR
Windows: Press [Ctrl] + [H]
The Find and Replace dialog box appears.
 In the Find what text box, type the text or data to be found
 In the Replace with text box, type the text or data to replace the information
found
 OPTIONAL: Adjust the searching options
 Click FIND NEXT The first occurrence is highlighted.
 Click REPLACE or REPLACE ALL the old information is replaced with
the
new.
WARNING: Use the Replace All option with caution. If you do not first select
specific cells to change, this option will replace the selected information
throughout the entire document.
 To close the dialog box, click CLOSE
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To Change the Worksheet Tab Colour
Click on the tab(s) of the worksheets you want to re-colour. To select more than one
tab hold down the CTRL key on the keyboard and click on each tab with the mouse
pointer.
Choose Format > Sheet > Tab Colour to display the Format Tab Colour Palette.
Pick a colour.
Click OK.
Preparing to Print
Before sending your work to the printer you should first check your page setup.
From the File menu choose Page Setup. The Page Setup dialog box appears.
There are a number of different sections in this dialog box – Page, Margins,
Header/Footer and Sheet, which are discussed below. It is from the Page Setup dialog
box that all changes to the printed copy can be made.
Page setup
Page tab
Click on the Page tab.
Set the required orientation by clicking on either Portrait or Landscape.

Select your choice of
orientation here.

Choose to scale your
worksheet or select Fit
to to condense your
worksheet to print on a
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PART TWO
SEXUALITY EDUCATION
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INTRODUCTION
Adolescent sexuality refers to sexual feelings, behavior and development in
adolescents (9-19years of age) and is a stage of human sexuality. Sexuality is often
a vital aspect of teenagers' lives. The sexual behavior of adolescents is, in most
cases, influenced by their culture's norms and mores, their sexual orientation, and
the issues of social control such as age of consent laws. Sex education, also called
"Sexuality Education" or informally "Sex Ed" is a broad term used to describe
education about human sexual anatomy, sexual reproduction, sexual intercourse,
human sexual behavior, and other aspects of sexuality, such as body image, sexual
orientation, dating, and relationships. Common avenues for sex education are
parents, caregivers, friends, school programs, religious groups, popular media, and
public health campaigns.
Adolescence is shrouded in myths and misconceptions about sexual health and
sexuality. In The Gambian culture, talking about sex is a taboo. Consequently, little
information is provided to adolescents about sexual health. Instead, young people
learn more about sexual and reproductive health from uninformed sources, which
results in the perpetuation of myths and misconceptions about puberty,
menstruation. During the transition to adulthood, lack of knowledge and awareness
about reproductive organs, physiological changes, or sexuality can promote
psychosocial stress. This is particularly so for girls, who also face gender
discrimination.
In humans, mature sexual desire usually begins to appear with the onset of
puberty. Sexual expression can take the form of masturbation or sex with a partner.
Sexual interests among adolescents, as among adults, can vary greatly. Sexual
activity in general is associated with various risks including unwanted pregnancy
and sexually transmitted diseases including HIV/AIDS. The risks are elevated for
young adolescents because their brains are not neurally mature; several brain
regions in the frontal lobe of the cerebral cortex and in the hypothalamus important
for self control, delayed gratification, and risk analysis and appreciation are not fully
mature until ages 25-30. Partially because of this, most adolescents are less
equipped than adults to make sound decisions and anticipate consequences of
sexual behavior.
Adolescents are entitled to grow up as healthy and responsible members of the
society. Adolescents in all society learn their responsibilities towards their family
and elderly by observing and following the behavior of others. Due to rapid social
change all over the world, the young generation is presently facing an enormous
problem in coping with the erosion of traditional family, social life, and values.
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Under this environment adolescent sexuality education can help the adolescents
especially in the transition from childhood to youth (adulthood).
Adolescents are very curious by nature, can easily adapt new ideas, learn quickly,
and also apply their knowledge. So the appropriate time of learning about
adolescent life is the adolescent stage itself. Adolescent girls become fertile
following the menarche (first menstrual period), which occurs in The Gambia at an
average age of 12.5, although it can vary widely between different girls. After
menarche, sexual intercourse (especially without contraception) can lead to
pregnancy. The pregnant teenager may then miscarry, have an abortion, or carry
the child to full term.
Pregnant teenagers face many of the same obstetrics issues as women in their 20s
and 30s. However, there are additional medical concerns for younger mothers,
particularly those under 15 and those living in developing countries; for example,
obstetric fistula is a particular issue for very young mothers in poorer regions. For
mothers between 15 and 19, age in itself is not a risk factor, but additional risks
may be associated with socioeconomic factors; for example pregnant teenagers are
less likely than women over 20 to receive early prenatal care.

NOTICEABLE ISSUES FOR ADOLESCENTS
Physical







The process of rapid physical changes in adolescence is called puberty. It
starts gradually, from around eleven years for girls and thirteen for boy. Girls
start these changes before boys and will, for the first three or four years,
appear to be maturing much faster. After this, boys catch up.
For girls: menstrual periods, growth of under-arm, body and pubic hair.
It is not surprising that, with the speed of these changes, some adolescents
become very concerned about their appearance. They may need a lot of
reassurance, especially if they are not growing or maturing as quickly as their
friends.
Growth and development uses a lot of energy, and this may be why teenagers
often seem to need so much sleep. Their getting-up late may be irritating, but
it may well not be just laziness.
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Psychological














As well as growing taller, starting to shave or having periods, people of this
age start to think and feel differently. They make close relationships outside
the family, with friends of their own age. Relationships within the family also
change. Parents become less important in their children's eyes as their life
outside the family develops.
Real disagreements emerge for the first time as young people develop views
of their own that are often not shared by their parents. As everybody knows,
adolescents spend a lot of time in each other's company, or on the telephone
to each other. Although this can be irritating to parents, it is an important way
of becoming more independent. These friendships are part of learning how to
get on with other people and gaining a sense of identity that is distinct from
that of the family. Clothes and appearance are a way of expressing solidarity
with friends, although teenage children are still more likely to get their values
from the family.
Parents often feel rejected, and in a sense they are. But this is often
necessary for young people to develop their own identity. Even if you have
rows and arguments, your children will usually think a lot of you. The
rejections and conflicts are often not to do with your personalities, but simply
with the fact that you are parents, from whom your children must become
independent if they are to have their own life. As they become more
independent, young people want to try out new things, but often recognize
that they have little experience to fall back on when things get difficult. This
may produce rapid changes in self-confidence and behavior - feeling very
adult one minute, very young and inexperienced the next.
Being upset, feeling ill or lacking confidence can make them feel vulnerable.
They may show this with sulky behavior rather than obvious distress. Parents
have to be pretty flexible to deal with all this, and may feel under
considerable strain themselves.
Adolescence is the time when people first start in earnest to learn about the
world and to find their place in it. This involves trying out new experiences,
some of which may be risky or even dangerous.
Young people can crave excitement in a way that most adults find difficult to
understand - and exciting activities may be dangerous. Fortunately, most
people manage to find their excitement in music, sport, or other activities that
involve a lot of energy but little real physical risk.
When they do experiment - with drink or drugs or smoking - it is usually with
friends. If a young person does this alone, they are in much greater danger.
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Warnings from older adolescents will usually be taken more seriously than
those from parents.
Emotional Problems






Over-eating, excessive sleepiness and a persistent over-concern with
appearance may be signs of emotional distress.
Anxiety may produce phobias and panic attacks. Recent research suggests
that emotional disorders are often not recognized, even by family and friends.
Depression:
At some time, 4 out of 10 adolescents have felt so miserable that they have
cried and have wanted to get away from everyone and everything.
During their adolescence, more than 1 in 5 teenagers think so little of
themselves that life does not seem worth living. In spite of these powerful
feelings, depression may not be obvious to other people.

Sexual Problems













The dramatic physical changes of adolescence can be very worrying to some
teenagers, especially to those who are shy and who don't like to ask
questions. At the other end of the scale, some express their concern with
excessive bragging about sexual ability and experiences.
More than half of young people in the UK will have had their first experience
of sex before the age of 16 and so the risk of pregnancy is a significant part of
adolescent life.
Those who start having sex early are at greater risk of early pregnancy and
health problems. Sexually transmitted diseases are common. HIV infection
and AIDS are becoming more common.
Crushes on someone of the same sex are common in adolescence. Some go
on to be gay, most don't.
Sensitive support, clear guidance and accurate information about these
different aspects of sex are essential - from parents, schools, family doctors,
and family planning clinics.
Most adolescents choose their partners quite carefully. Sleeping around and
risky unprotected intercourse are often signs of underlying emotional
problems. They may also be the signs of a risk-taking lifestyle - adolescents
who take risks in one way tend to take risks in other ways as well.
Recent research suggests that girls who are close to their parents are less
likely to become pregnant in their teenage years.
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Teenagers can get confidential advice on contraception from their GP, who
does not have to inform their parents. Emergency contraception from
pharmacies is only available to those aged 16 or over.

Behavior Problems




Teenagers and their parents complain about each other's behaviour. Parents
often feel they have lost any sort of control or influence over their child.
Adolescents want their parents to be clear and consistent about rules and
boundaries, but at the same time may resent any restrictions on their growing
freedom and ability to decide for themselves.
If disagreements are common and normal, when should you worry?
Experience suggests that children are at greater risk of getting into trouble if
their parents don't know where they are. So, try to make sure that you know
where they are going and what they are up to. If you really don't know, you
need to find out.

School Problems


Refusal to go to school can be due to:
 difficulties in separating from parents
 being perfectionist, and becoming depressed because they can't do as

well as they would want to
 disturbed family life, with early separation from or death of parent.
 an established pattern which may have started at primary school. Such
children often have physical symptoms, such as headache or stomachache.






Those who go to school, but then play truant, are usually unhappy at home
and frustrated at school. They prefer to spend their days with others who feel
the same way.
Emotional problems will often affect school work - worry about oneself, or
about what is going on at home, makes it difficult to concentrate. Pressure to
do well and to pass exams may come from parents or teachers, but
adolescents usually want to do well and will push themselves. Excessive
nagging can be counter-productive. Exams are important, but they should not
be allowed to dominate life or to cause unhappiness.
Bullying can cause all of the above. Around 1 in 10 secondary school children
is bullied at some point, about 1 in 20 is bullied every week. Short children
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are more likely to be bullied. If you are worried that this is happening, talk to
the school to make sure that they enforce their bullying policy.
Problem of drugs, solvents and alcohol








Many teenagers experiment with alcohol and illegal drugs. Around 1 in 3 of 15
year olds in England has used drugs at some time.
Although cannabis has been widely felt to be relatively harmless, there is now
good evidence that it can make mental health problems worse in adolescence
and can double the risk of developing schizophrenia.
Despite publicity about other drugs, alcohol is the most common drug to
cause problems for adolescents.
You should consider the possibility of drug or alcohol use when you notice
sudden or dramatic changes in behavior.
Find out about any drugs your children may be using - see the telephone and
web resources at the end of the leaflet.
What if they ask about the drugs you used to use in your younger days?
Honesty is generally the best policy, although it is probably worth stressing
the differences in drugs available now. For example, much of the cannabis
available today is many times stronger than was available 20 years ago, and
we now know a lot more about its risks to both physical and mental health.

Abuse




Physical, emotional and sexual abuse may occur in adolescence and may
cause many of the problems mentioned above.
Children or teenagers who are being abused can find someone to talk to at
ChildLine.
Families with these problems need expert advice and should seek help.

Mental Illness
Much less often, changes in behavior and mood can mark the beginning of more
serious psychiatric disorders. Although uncommon, manic depression and
schizophrenia may emerge for the first time during adolescent years. Extreme
withdrawal may indicate schizophrenia, though there are usually other explanations
for such behavior.
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Pregnancy
When can girls become pregnant; how girls become pregnant; symptoms of
pregnancy; care of pregnant girls, serious problems during pregnancy; things to be
avoided by the pregnant girls; preparation for safe delivery; measures to be
followed by the pregnant girls; risk of pregnancy at young age; sterility.
FAMILY PLANNING AND BIRTH CONTROL
What is family planning; need of family planning; family planning adoption ways;
description of family planning methods:
 Temporary methods; oral birth control pill; birth preventive injections;
NORPLANT; copper-T (IUD); Temporary birth control methods-condom; foam
tablet; menstruation regulation (MR).
 Permanent methods-vasectomy; ligation. Natural birth control methodsabstinence; withdrawal; rhythm or safe-period; traditional wrong notions
about family planning; effectiveness of the methods of family planning.
SEXUALLY TRANSMITTED DISEASES
Gonorrhea; Syphilis; AIDs
In The Gambia, as in many countries in the industrialized world and elsewhere,
people embark on their sexual lives when they are in their teens-often in there
early or mid-teens. And yet to date, there is no reproductive health education in
schools that would prepare girls and boys to avoid early sex or to adopt safer
sexual practices. High levels of teen pregnancies, and pregnancy outside of
marriage, do tell us two things: young people are very sexually active, and few
of them use condoms. If young people are having unprotected sex with several
partners, or if their single partner has ever had other partners, they are exposed
not just to pregnancy but to infection with sexually transmitted diseases,
including the one that can kill them: HIV.
Often, girls become infected at younger ages than boys. This age gap at infection
indicates that young girls are getting infected through sex with older men. Many
girls may choose such relationships because they come with gifts, money or
other favors attached. But some will simply have been powerless to resist.
Unwilling sex with an infected partner carries a high risk of HIV infection for girls.
As infection rises in the general population, so does the likelihood of
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encountering an infected partner (especially an older partner) early in one's
sexual career. Over time, then, new infections become increasingly concentrated
in the youngest age groups.
Young people continue to be at risk catching of HIV/AIDS throughout their
sexually active lives, and all should benefit from services and information that
allow them to reduce their risk of infection. However, efforts to promote safer
behavior are especially crucial for young people, who in mature epidemics are
those at greatest risk. Prevention efforts also seem to have a greater chance of
success among younger people than among people whose sexual habits are well
ingrained.
Many school going youth (girls and boys) have resorted to exchanging sex for
material gains, all of which increase the risk of contracting HIV and other STIs.
Young girls face an increased risk of unwanted pregnancies and unsafe abortions,
while health infrastructure continues to deteriorate, hampering the population’s
access to information and services related to reproductive health. Reproductive
health issues and concerns, including those related to STIs, HIV/AIDS, gender
and GBV, are ignored or the concerned parties respond passively to them.
Sexual education and consciousness development of adolescents is a necessary
prerequisite for avoiding these diseases.
HIV Infected – Someone who has been diagnosed with HIV.
HIV Affected – Someone who is not infected with HIV, but who feels her/his life is
in some way touched by HIV. For example, a person’s mother / sister / friend /
partner has been diagnosed with HIV.
Anonymous HIV Testing – When people go for anonymous HIV testing, they are
not asked to give any information about themselves; this includes their name, their
address, and their health number. If you test positive, the doctor will report that
someone has tested positive for HIV, but will not report your name because s/he
does not know it.
Confidential HIV Testing – When people go for confidential HIV testing, they give
their personal information (name, address, health number) to the person who does
the test.
Youth – people between the ages of 15 and 29. The youth who talked to us were
between the ages of 19 and 24.
Youth Allies – Our definition of a “youth ally” is someone who is over the age of 24
and who either works with or advocates for (assists and supports) youth.
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What is HIV and AIDS?
HIV stands for Human Immunodeficiency Virus. HIV is carried through the
following bodily fluids: blood, semen (cum), and vaginal fluids (including menstrual
blood and breast milk).These are the only bodily fluids that have enough HIV in
them to infect someone. You can become infected with HIV if one of these four
bodily fluids, from someone with HIV, gets into your body and finds a way to get
into your bloodstream.
Some of the most common ways that you can get HIV are:
 Through unprotected sex (oral, anal, and vaginal contact without use of
condoms, dental dams or gloves);
 From mother to baby while giving birth or through breast milk; or
 From blood transfusions. HIV attacks your immune system – the part of you
that fights off infection – by damaging your T-helper cells (white blood cells
that help fight infection).
AIDS stands for Acquired Immune Deficiency Syndrome.
When you have HIV, because of damage to your immune system, you begin to
experience health problems. At first these may be small problems, but over time the
illnesses become more serious. The amount of time that it takes HIV to begin to
affect a person’s health varies widely from person to person. When you are
diagnosed with one of the serious illnesses that are called “AIDS-defining,” you are
considered to have AIDS.
Most frequently asked questions
1. What is HIV and how is it transmitted?
HIV stands for human immunodeficiency virus and it is the virus that causes AIDS.
People with HIV have what is called HIV infection. The most common ways that HIV
is transmitted are by having unprotected sexual intercourse with an HIV infected
person, by sharing needles or injection equipment with an injecting drug user who is
infected with HIV, from HIV infected women to their babies during pregnancy,
delivery or breastfeeding and finally through transfusions of infected blood. HIV is
not transmitted through normal, day-to-day contact.
2. What is AIDS? What causes AIDS?
AIDS – the Acquired Immuno-Deficiency Syndrome – is the late stage of infection
caused by the Human. Immuno-deficiency Virus (HIV). A person who is infected
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with HIV can look and feel healthy for a long time before signs of AIDS appear. But
HIV weakens the body's defense (immune) system until it can no longer fight off
infections such as pneumonia, diarrhea, tumors, cancers and other illnesses. Today
there are medical treatments that can slow down the rate at which HIV weakens the
immune system (anti-retroviral treatment). There are other treatments that can
prevent or cure some of the illnesses associated with AIDS, though the treatments
do not cure AIDS itself. As with other diseases, early detection offers more options
for treatment and preventative health care.
3. Can I get AIDS from "casual contact" with an infected person?
No. This means that it is OK to play sports and work together, shake hands, hug
friends or kiss them on the cheek or hands, sleep in the same room, breathe the
same air, share drinking and eating utensils and towels, use the same showers or
toilets, use the same washing water and swim in the same swimming pool. You
cannot get infected through spitting, sneezing or coughing or through tears or
sweat, or through bites from mosquitoes or other insects.
4. Can someone infected with HIV look healthy?
There is no way of knowing whether someone is infected just by looking at them. A
man or woman you meet at work, at school, in a sports stadium; in a bar or on the
street might be carrying HIV – and look completely healthy. But during this time of
apparent health, he or she can infect someone else.
5. Is there a cure for HIV/AIDS?
There is no cure for HIV/AIDS. Although some very strong drugs are now being
used to slow down the disease, they do not get rid of HIV or cure AIDS. The drug
treatments are called Highly Active Anti-Retroviral Therapies (HAART). They are a
mix of drugs that help to reduce the level of HIV in the blood. HAART can help to
slow down HIV and keep some people healthy longer. Even though HAART work
better than anything else so far, they do have some problems. They do not work for
all people and it is not sure how well they will work over time, considering their high
price and significant adverse effects.
6. Is there a “morning after” pill that prevents HIV infection?
You may have heard about a morning after pill for HIV. In fact this is Post-Exposure
Prophylaxis (PEP). It is not a single pill, and it does not prevent HIV/AIDS. PEP is a
4 week treatment that may reduce the risk of acquiring HIV for people who have
been exposed to the virus. It does not eliminate the risk. So far, PEP has mostly
been used to treat health care workers who have been exposed to HIV at work.

- 42
-

Right now, there is no proof that PEP works, or that it is safe. PEP is not at all a
solution to prevent HIV transmission.
7. What should I do to protect myself from HIV?
Since there is no vaccine to protect people against getting infected with HIV, and
there is no cure for AIDS the only certain way to avoid AIDS is to prevent getting
infected with HIV in the first place. The best prevention method is the adoption of
safe sex behavior. Safe sex includes using a condom – but, using a condom
correctly, and using one every time you have sex. You should learn how to use
condoms and how to negotiate the use of condoms with your partner. For
information about effective and healthy use of condoms, you should consult health
services for young people and pharmacies.
8. What are the risks of getting HIV through injecting drug use?
The only way to be sure you are protected against HIV is not to inject drugs at all. If
you do inject drugs you can avoid the very high risk of being exposed to HIV by
always using sterile, un-used needles and syringes, and using them only once.

FOOD AND NUTRITION IN THE ADOLESCENT STAGE
Nutrition and balanced diet
Adolescence is the transition period between childhood and adulthood, a window of
opportunity for the improvement of nutritional status and correcting poor nutritional
practices. This is about the same period puberty sets in, typically between the ages
of 10 and 13 years in girls. Adolescence is characterized by the growth spurt, a
period in which growth is very fast. During this time, physical changes affect the
body's nutritional needs, while changes in one's lifestyle may affect eating habits
and food choices. Adolescent nutrition is therefore important for supporting the
physical growth of the body and for preventing future health problems. All parents
should therefore pay particular attention to the nutritional needs of their teenagers.
Any nutritional deficiency experienced during this critical period of life can have an
effect on the future health of the individual and their offspring. For example, failure
to consume an adequate diet at this time can result in delayed sexual maturation
and delayed or retarded physical growth. The rapid physical changes of adolescence
have a direct influence on a person's nutritional needs. The growth spurt that occurs
in adolescence, second only to that in the first year of life, creates increased
demands for energy and nutrients. Nutritional status and physical growth are
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dependent on one another such that optimal nutrition is a requisite for achieving full
growth potential.
Nutrition of the adolescent girl is particularly important but under-nutrition (too little
food or food lacking required nutrients) in adolescents frequently goes unnoticed by
their families or the young people themselves. Adolescence is a time to prepare for
the nutritional demands of pregnancy and lactation that girls may experience in
later life. Under-nutrition negatively affects adolescent girls by:






Affecting their ability to learn and work at maximum productivity;
Increasing the risk of poor obstetric outcomes for teen mothers;
Arresting the healthy development of future children;
Affecting sexual maturation and growth: and
Preventing the attainment of normal bone strength and the development of
healthy teeth if a youth doesn't get enough calcium.

It is also a well established fact that children born to short, thin women are more
likely themselves to be stunted and underweight (low weight for age). What is more
worrying therefore is that the negative effects of adolescent malnutrition persist
throughout a woman's reproductive life. The important nutrients that need to
increase during adolescence include energy, protein, calcium, and iron.
Energy
Energy needs of adolescents are influenced by activity level, basal metabolic rate,
and increased requirements to support pubertal growth and development.
Adolescents need additional energy for growth and activity. Adolescent girls need
approximately 2,200 calories each day. This is a significant increase from childhood
requirements. To meet these calorie needs, adolescents should choose a variety of
healthful foods, such as lean protein sources, low-fat dairy products, whole grains,
fruits, and vegetables. In an attempt to meet their energy needs, adolescents can
fall prey to unhealthy, coercive and aggressive advertisement. They must therefore
be well informed in the choice of healthy foods both at home and in school.
Fats and oils
During adolescence, dietary fat continues to play important roles as an energy
source, a significant cell structural component, a precursor to agents of metabolic
function and a potent gene regulator. Effective strategies for reducing fat intake in
children include the use of skim milk and choosing only lean meat.
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Protein
Protein needs of adolescents are determined by the amount of protein required for
maintenance of existing lean body mass and the development of additional lean
body mass during the adolescent growth spurt. In effect, protein is important for
growth and maintenance of muscle. Adolescents need between 45 and 60 grams of
protein each day. Most teens easily meet this requirement with their intake of beef,
pork, chicken, eggs, and dairy products. Protein is also available from certain
vegetable sources, including tofu and other soy foods, beans, and nuts. These foods
should be included in the diets of vegetarians especially. When protein intakes are
consistently inadequate, reductions in linear growth, delays in sexual maturation
and reduced accumulation of lean body mass may occur.
Calcium
It is estimated 45% of peak bone mass is attained during adolescence and so
adequate calcium intake is important for the development of dense bone mass and
the reduction of the lifetime risk of fractures and osteoporosis. Additionally, calcium
needs during adolescence are greater than they are in either childhood or adulthood
because of the increased demand for skeletal growth. Adequate calcium intake is
essential also for development of strong and dense bones during the adolescent
growth spurt. Inadequate calcium intake during adolescence and young adulthood
puts individuals at risk for developing osteoporosis later in life. Milk provides the
greatest amount of calcium in the diets of adolescents, followed by cheese, ice
cream and frozen yogurt.
Iron
Iron is vital for transporting oxygen in the bloodstream. A deficiency of iron causes
anaemia, which leads to fatigue, confusion, and weakness. With the onset of
adolescence, the need for iron increases as direct consequence of rapid growth and
the expansion of blood volume and muscle mass. As adolescents gain muscle mass,
more iron is needed to help their new muscle cells obtain oxygen for energy. The
onset of menstruation imposes additional iron needs for girls. Good sources of iron
include beef, chicken, pork, legumes (including beans and peanuts), enriched or
whole grains, and leafy green vegetables such as spinach.
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Zinc
Zinc is important in adolescence because of its role in growth and sexual
maturation. Zinc is naturally abundant in red meats, shellfish, and whole grains.
Additionally, many breakfast cereals are fortified with zinc.
Adolescents tend to eat differently than they did as children. Preoccupied with afterschool activities and engagement in active social endeavours, adolescents are not
always able to sit down for three meals a day. These apparent busy schedules may
lead to meal skipping, snacking throughout the day, and more eating away from
home. Many teens skip breakfast, for example, but this meal is particularly
important for getting enough energy to make it through the day, and it may even
lead to better academic performance. When teens skipping meals at home is
prevalent, the likelihood of purchasing fast food from a restaurant, vending
machine, or convenience store will be high. These foods tend to be high in fat and
sugar and they provide little nutritional value. More importantly, eating too many
fast foods can lead to weight gain and which may predispose one to diseases such
as diabetes and heart disease.

POTENTIAL NUTRITION-RELATED PROBLEMS FOR ADOLESCENT CHILDREN
Poor eating habits during the critical adolescent years may lead to both short and
long term health consequences including obesity, osteoporosis, and sexual
maturation delays. Adolescents are at risk of obesity, obesity-related chronic
diseases, and eating disorders.
Obesity
Obesity is associated with an increased risk of obesity-related diseases like diabetes
and heart disease. Experts have linked this rise in obesity to lack of physical activity
and an increase in the amount of fast food and "junk food" available to adolescents.
Staying active and avoiding sugary drinks and fatty snacks foods will promote a
healthy weight for adolescents.
Eating disorders
Over-eating, under-eating and eating disorders can have serious health impacts.
Adolescents tend to be very conscious of appearances and may feel pressured to be
thin or to look a certain way (that is self image). Fear of becoming obese may lead
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to overly restrictive eating habits. Some adolescents even go to the extent of
resorting to self-induced vomiting in an attempt to control their weight.
Though adolescents in general are nutritionally vulnerable, certain groups of
adolescents may be at greater risk for nutritional inadequacies. This category of
adolescents includes the following:
Pregnant Adolescents
When a teenager becomes pregnant, she needs more nutrients than her nonpregnant colleague to support both her baby and her own continued growth and
physical development. If her nutritional needs are not met, her baby may be born
with impaired foetal growth and the subsequent low birth weight or other health
problems. For the best outcome, pregnant adolescents need to seek prenatal care
and nutrition advice early in their pregnancy.
Athletes
Adolescents involved in athletics may feel pressure to be at a particular weight or to
perform at a certain level. Some young athletes may be tempted to adopt unhealthy
behaviors such as crash dieting, taking supplements to improve performance, or
eating unhealthy foods to fulfill their hearty appetites. A balanced nutritional outlook
is important for good health and athletic performance.

PERSONAL HEALTH-CARE
When a young boy or girl starts to mature, many physical changes take place. Some
of these changes include an increase in body hair, an increase in sweat
(accompanied with body odor), facial skin problems and an oily scalp. Good
personal hygiene should be practiced to combat the problems associated with these
changes and to avoid contracting any diseases related to poor personal grooming.
Use the following personal hygiene tips for adolescents on a day-to-day basis if you
are an adolescent who wants to practice good personal hygiene.
Hair Hygiene
Making sure your hair is clean becomes more of a priority when a boy or girl
reaches adolescence because the scalp produces more oil at this time. This makes it
necessary for the use of a shampoo made for oily hair and more frequent washing.
Wash your hair every day if necessary.
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Facial Skin Hygiene
Wash your face two times a day without fail. Adolescents go through a period in
which their oil glands produce more oil, and some adolescents wind up with acne.
Use skin care products made to treat acne, and if your acne symptoms do not
improve after eight weeks, go to a dermatologist to see what he can do to help you.
Avoid using anything on your face that contains oil if you have acne, and do not rub
the skin on your face with a heavy hand. Do not spend too much time under the
sun, and keep your hands off your face. Go to a licensed esthetician for an acne
facial, and ask her to extract blackheads and pimples.
Body Hygiene
Bathe each day with body wash and water to cleanse the sweat from your body.
Sweat creates odor, and an adolescent will sweat more because his sweat glands
are working more diligently at this time in his life. Sweat will also have a heavier
odor in an adolescent. Apply deodorant or antiperspirant to underarms to keep
sweating under control and to mask underarm odor if needed.
Body Hair Hygiene
Shave the hair on your face with an electric shaver to look well groomed if you are a
guy. Use a nonelectric razor if you do not have an electric shaver, and use a new
blade in the razor to avoid cutting your skin. Girls should shave their legs and
underarms with an electric razor to avoid cutting themselves.
Oral Hygiene
Use a new or fairly new toothbrush and toothpaste that contains fluoride with which
to brush your teeth after meals, and floss at night. Brushing and flossing may help
to prevent bad breath and cavities. Make it a point to practice good oral hygiene
every day. Go to the dentist every six months to have your teeth checked and
cleaned. See your dentist if you have persistent bad breath.
Vaginal Hygiene
Do not douche, as doctors do not recommend douching. The vaginal area of the
body produces fluids that cleanse the vagina naturally. Wash the pubic area with a
mild soap and water to keep the area clean and free of odor. See a gynecologist if
you experience abnormal itching, pain, a burning sensation or a yellow/green or
lumpy white fluid coming out of your vagina. Make an appointment with your doctor
if you experience pain when you urinate.
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CONCLUSION /RECOMMENDATIONS
Sexual and reproductive health encompasses a woman’s ability to exercise her right
to control what happens to her body; to make choices about whether, when and
with whom to have intimate relationships, and if and when to have children; to
protect herself from diseases associated with reproduction; and to have informed
access to health services. As a prerequisite for sexual and reproductive health,
quality health services must exist, and women and girls must live in environments
that enable them to seek services and practice healthy behaviors.
What happens during adolescence shapes a girl’s (or boy’s) adulthood. Choices
made by adults about a girl’s education, healthcare, employment and so forth will
determine her future place not only in her family but in the economy and civil
society. They may even empower or hinder her from making informed choices of
her own. Adolescence for girls is therefore a transition into new realms of
discrimination, vulnerability and risks but also, with the appropriate support, it could
create new opportunities.
Research clearly shows that comprehensive sex education programs do not
encourage teens to start having sexual intercourse; do not increase the frequency
with which teens have intercourse; and do not increase the number of a teen's
sexual partners. At the same time, evaluations of publicly funded abstinence-only
programs have repeatedly shown no positive changes in sexual behaviors over time.
Young people need honest, effective sex education – not ineffective, shame-based.
There is a clear need for primary prevention interventions for unwanted pregnancies
and STDs among adolescent girls in The Gambia. However, there is currently almost
no empirical research on psycho-educational groups for healthy sexuality of female
teens. Because there is a growing body of evidence suggesting that sex education
programs can be effective at reducing adolescents’ sexual risk behaviors, unwanted
pregnancies, and STDs, and group counseling has been shown to be particularly
effective with adolescent females, future research should examine the effectiveness
of sex education groups for teenage girls.
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